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Overview 
 
The intent of the Detailed Modeling module is to move beyond template-based modeling and focus 
on detail-oriented modeling. Because of the complexity of detail-oriented modeling, the module will 
focus on a wide range of concepts. This includes traditional corridor modeling, complex plan 
geometry, proposed terrain model development, and the introduction to a number of additional 
tools/ techniques that fall outside of the traditional template-based modeling scope. By leveraging 
these tools and techniques, the user can take the traditional template-based corridor to a whole 
new level of detail and complexity. In addition to the tools that were introduced in the previous 
Corridor Modeling modules, the Terrain and Model Detailing ribbons will also play a major role 
throughout the Detailed Modeling module. 
 

Model Detailing Ribbon 

 
 

Terrain Ribbon 

 
 

Key Concepts, Tools and Terminology 

 
Design Intent 
Design Intent is the act of preserving rules and relationships established during the design process in 
order to realize downstream benefits of automatic updates. 

 
Linear Templates 
Templates that can be applied quickly and easily to 3D linear elements but with less functionality 
when compared to corridor templates.  
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Surface Templates 
A template made of components with an associated depth. These components are closed shapes such 
as asphalt, concrete, aggregate, grass etc. Surface Templates are used to apply material thickness to 
the surface of a terrain.   
 

Terrain Modeling  
A set of three-dimensional triangles mathematically computed from point data collected on the 
surface being modeled. Models are used to define highly irregular surfaces, particularly the surface of 
the earth, but can be generated for proposed surfaces, subsurface geotechnical layers, etc.  Terrain 
models are also referred to as digital terrain models (DTMs), triangulated irregular networks (TINs), or 
triangulated surfaces. 

 

Exercise 1 - Street Turnout Modeling  
 
In this exercise, you will learn how to model a Side Street Turnout and Concrete Channelization 
Island. This includes the mainline pavement shearing, horizontal/vertical layout, application of linear 
templates, proposed terrain model development, surface template application, and various element 
profiling techniques. Design Intent will continue to be a major focus.  
 
Throughout this exercise you will be working with NCDOT 2D dgn files exclusively. All design and 
corridor manipulation will be carried out within a 2-dimensional design plane. 
 
1. Launch OpenRoads Designer CONNECT Edition 
             Double-click on the NCDOT Roadway OpenRoads icon on your desktop to launch 
             OpenRoads Designer into the NCDOT Roadway workspace. 
 
2. Set the Workspace and Workset 
             Select DOT-US North Carolina from the Workspace menu. 
             Select NCDOT R-2635C (Training) from the Workset menu. 

 
 
 

 
 

3. Open the Exercise 1 Corridor (CMD) dgn file and zoom in closely to the Y8 Corridor 
A. Click the browse button and path to the Module 11 (Detailed Modeling) folder and 

open the R-2635C-RDY_CMD_Exercise1.dgn file. 

Χ 
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B. Zoom in near the Y8 Corridor as shown below. Notice that the Y8 alignment already has a base 
corridor. This base Y8 corridor will serve as a starting point for the Detailed Modeling exercise.  
See the Initial Corridor Modeling Module for detailed instructions for initial corridor 
development. 

 
Note: All reference files that are required for the Detailed Modeling module have already been 
attached to the R-2635C_RDY_CMD_Exercise1.dgn file. 
 

4. Load Civil AccuDraw and the Feature Definition Toggle Bar 
A. Click on the Civil AccuDraw button (Geometry > General Tools > Civil Toggles > Civil 

AccuDraw) to load the Civil AccuDraw toolbar.  
B. Click on the Feature Definition Toggle Bar button (Geometry > General Tools > 

Standards > Feature Definition Toggle Bar) to load the Feature Definition Toggle 
Bar. 

 
Tip: Both of these toolbars will be used throughout the design/modeling process. Because of  
ǘƘƛǎΣ ƛǘΩǎ ǊŜŎƻƳƳŜƴŘŜŘ ǘƘŀǘ ōƻǘƘ ŀǊŜ ŘƻŎƪŜŘ ŦƻǊ Ŝŀǎȅ ŀŎŎŜǎǎΦ  

 
5. Adjust the level and reference file display as needed to better facilitate design/modeling  

A. With the View 1, Default view in focus, turn the display of the Default-3D view off as shown 
below. 

 
 

Y8 
  CORRIDOR 
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B. Notice that the 3D model has been turned off, leaving just the linework. Depending on your 
prefence, you may choose to turn off additional linear elements to avoid confusion. 

 

6. Open an additional 3D view to better facilitate 3D modeling 
A. Right-click within the View 1, Default view and hold to load the View Control 

menu.  From there, select the 2 Views Plan/3D option as shown below.  
 
 
 
 
 
 
 
 
 

B. This will load the View 2, Default-3D view in addition to the standard View 1, Default view as 
shown below. As you continue to develop your model you can now easily visualize it.  

 
 
 
 
 
 
 
 

C. Then, click the Tile button (View > Window > Tile) as shown below to tile the two (2)  
windows. This will make it easier to focus on both views at the same time. 

 
 
 
 
 

TILE 
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7. Layout the Horizontal Geometry for the Street Turnout 
A. From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition 

button and then select the Road_Edge of Travel feature from the (Linear > Roadway > 
Pavement) folder as shown below. Keep this Feature active throughout all steps that follow. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

B. Next, select the Single Offset Entire Element tool (Geometry > Horizontal > Offsets and 
Tapers > Single Offset Entire Element)  and then select the street turnout centerline (Y8A) 
when prompted to locate element.  

 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 

FEATURE 
DEFINITION 
DROPDOWN 

USE ACTIVE 
FEATURE 

DEFINITION 

STREET TURNOUT 
CENTERLINE (Y8A) 

Y8 
ALIGNMENT 
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C. Set the Offset parameter to 12.0000 and toggle on the Mirror option within the Single Offset 
Entire Element dialog and click through the prompts to accept. This will draw the left and right 
EOT lines for the Y8A street turnout.   

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
D. Now, select the Simple Arc tool (Geometry > Horizontal > Arcs > Arc Between Elements > 

Simple Arc).  Set the Radius parameter to 35.0000Ω and the Trim/Extend parameter to Back 
within the Simple Arc dialog as shown below. 
 

  

STREET 
TURNOUT  
RIGHT EOT 

STREET 
TURNOUT  
LEFT EOT 

Y8 
ALIGNMENT 
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E. When prompted to Locate First Element, select the Left EOT line for the street turnout (Y8A) 
and then select the Right EOT line for the Y8 Corridor as the Second Element. When selecting 
the Y8 Corridor Right EOT line you may notice multiple linear elements sitting on top of one 
another. To resolve this, Right-Click to cycle through them and choose the linear element on 
level P_RDY_TL_Edge_of_Travel.  LǘΩǎ ǾŜǊȅ IMPORTANT to select the correct linear element. 

 
 

F. After selecting both elements, click through the additional prompts to place the орΩ radius as 
shown below.   

 
 
 
 
 
 
 
 
 
 
 
 

STREET 
TURNOUT  
LEFT EOT 

Y8 CORRIDOR RIGHT EOT 
P_RDY_TL_EDGE_OF_TRAVEL 

Y8 
ALIGNMENT 

орΩ 
RADIUS 

Y8 
ALIGNMENT 
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G. Now, place a 35Ω radius return on the other side of the street turnout following the previous 
steps. This time select the Right EOT of the street turnout (Y8A) when prompted to Locate 
First Element and then the Right EOT line for the Y8 Corridor as the second.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

H. After selecting both elements, click through the additional prompts to place the орΩ radius as 
shown below.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Y8 CORRIDOR 
RIGHT EOT 

STREET 
TURNOUT  
RIGHT EOT 

Y8 
ALIGNMENT 

орΩ 
RADIUS 

Y8 
ALIGNMENT 
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I. Next, select the By Angle From Element tool (Geometry > Horizontal > Lines > Line From 

Element > By Angle From Element).  Set and lock the Skew parameter to 90̄  ллΩ ллέ, the Start 
Distance parameter to 0.0000, End Distance parameter to -30.0000, and Name to Y8A TIE 
within the By Angle From Element dialog as shown below. 

 
J. When prompted to Locate Element, select the centerline of the street turnout (Y8A).  Drag 

your mouse just beyond the radius returns and Left-Click the screen when prompted to Enter 

Start Point.  This will define the start point of a line from the Y8A alignment at a 90̄  skew as 
shown below. 
 

 
 
 
 
 
 
 
 
 
 
 

 

Y8 
ALIGNMENT 

Y8A 
ALIGNMENT 

START POINT 
LOCATION 
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K. Then, click through the additional prompts to finish placing the Y8A TIE line as shown below.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

L. Now, click on the line that was just placed and notice the Small Arrows that are displayed on 
the outer end of each side. These Arrows can be used to manipulate the element they are 
associated with.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Y8A TIE  

Y8A 
ALIGNMENT 

Y8 
ALIGNMENT 

MANIPULATOR 
ARROW 

MANIPULATOR 
ARROW  

LEFT 
EOT 

Y8A 
ALIGNMENT 

Y8A TIE  
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M. Left-Click and Drag the left side Manipulator Arrow just beyond the Left EOT of the Side 
Street (Y8A) as shown below.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

N. Next, modify the Y8A TIE line widths on both sides of the Y8A alignment to -12Ω as shown 
below.  The Y8A TIE line represents the location where the Side Street (Y8A) ties to existing.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

MANIPULATOR 
ARROW  

Y8A 
ALIGNMENT 

LEFT 
EOT 

Y8A TIE  

Y8A 
ALIGNMENT 

Y8A TIE  
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O. Next, select the Trim To Intersection tool (Drawing > Modify > Trim To Intersection) 
and trim the Street Turnout (Y8A) EOT and TIE lines and as shown below.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
8. Demonstrate the Horizontal Design Intent associated with the Street Turnout 

A. When the EOT lines were Trimmed in the previous step, a Rule was created. Click the EOT      

line that was drawn at a 90̄  degree angle from the Y8A alignment as shown below. Notice the 
Manipulator Handle that is displayed in the center. 

 
 
 
 
 
 
 
 
 
 
 
 

Y8A 
ALIGNMENT 

MANIPULATOR 
HANDLE 

Y8A 
ALIGNMENT 

Y8 
ALIGNMENT 

TRIM  

TRIM  
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B. Next, click, hold, and drag the Manipulator Handle at the intersection up and down along the 
Y8A alignment and notice that the line moves as well.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 

C. Now, Toggle Civil AccuDraw on and select the Station-Offset icon as show below.  
 
 
 
 
 
 
 

D. After activating Civil AccuDraw, click, hold, and drag the Manipulator Handle at the 
intersection again. Notice that the Civil AccuDraw dialog now loads as well, and is tracking 
your movement along the Y8A alignment as show below. 

 
 
 
 
 
 
 
 
 
 
 
 
 

TOGGLE CIVIL 
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ALIGNMENT 
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E. Key-in 10+75.00 and then left click the screen to place the line as shown below. Notice 
that the left and right EOT lines move as well because of the rule that was created previously 
when using the Trim To Intersection command.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

F. Toggle Civil AccuDraw off as shown below but keep the Civil AccuDraw toolbar loaded.  
 
 
 
 
 
 
 
 
 
 
 
 
 

TOGGLE CIVIL 
ACCUDRAW OFF 

Y8 
ALIGNMENT 
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9. Shear the Y8 pavement through the Y8A Side Street intersection  
A. From the Feature Definition Toggle Bar, toggle On the Use Active Feature Definition 

button and then select the CCE_Target_EOT_Shear_Out_RT feature from the (Linear > 
Roadway > Construction Class Element) folder as shown below.  

 
 
 
 
 
 
 
 
 
 
 
 

B. Select the Single Offset Partial option (Geometry > Horizontal > Offsets and Tapers > Single 
Offset Partial) as shown below and select the Y8 Alignment when prompted to Locate 
Element.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

TOGGLE OFF 
PERSIST SNAPS 
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USE ACTIVE 
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DEFINITION 
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C. When prompted for a Start Station, snap to the end of the left-side radius as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

D. Next, snap to the end of the right-side radius as shown below to place the shear line as shown 
below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

SNAP TO END 
OF RADIUS 

SNAP TO END 
OF RADIUS 

SHEAR LINE 
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E. Click the Y8 Corridor Object Handle, hover for a moment to display the menu, and then select 
the Add Corridor Reference option as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

F. After adding the Shear line as a Corridor Reference, the EOT is sheared as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Y8 
ALIGNMENT 

Y8A 
ALIGNMENT 

Y8 CORRIDOR 
OBJECT HANDLE 

ADD CORRIDOR 
REFERENCE 
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G. Notice that the pavement has also been sheared within the View 2, Default-3D view as well.  
 

 
 
10. Profile the Side Street (Y8A) EOT lines 

A. Click the Y8A TIE line shown below, hover for a moment to display the menu, and then 
select the Open Profile Model option. 

 
 

 
 
 
 

SHEARED  Y8 
PAVEMENT 

Y8A TIE 

OPEN PROFILE 
MODEL 

Y8A 
ALIGNMENT 
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B. When prompted to Select or Open View, click the View 5 option, within the View Groups 
group (View > View Groups) and then, left click within the view to open the Y8A TIE line 
profile view as shown below.  

 

C. Now, Click the existing Y8A TIE line shown below, hover for a moment to display the Profile 
Menu as shown below, then select the Set as Active Profile option. 

 
 
 
 
 
 
 
 
 
 
 

VIEW 5 

SET AS ACTIVE 
PROFILE 

EXISTING Y8A 
TIE  
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Y8A TIE  

D. Notice in the View 2, Default 3D window that the Y8A TIE line is now displayed in the 3D 
model. This is because it now has a vertical attribute associated with it.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

E. Move your mouse мнΩ to the left of the Y8A alignment and notice the pink line as displayed 
below. This line represents the Y8A left EOT line in its original state before it was trimmed. This 
line acts as a parent to the small, trimmed EOT section that is still visible.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ORIGINAL 
LEFT EOT  

TRIMMED 
LEFT EOT  

Y8A 
ALIGNMENT 



 

Module 11 - Detailed Modeling 
 

 
 

Page | 23  
 
 

F. Click the Left EOT line shown below, hover for a moment to display the menu, and then 
select the Open Profile Model option. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
G. When prompted to Select or Open View, click the View 5 option, within the View Groups 

group (View > View Groups) and then, left click within the view to open the LEFT EOT profile.  
 
 

 
 
 
 
 

 

LEFT EOT  

Y8A 
ALIGNMENT 

OPEN PROFILE 
MODEL 

VIEW 5 
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H. Now, click the existing Y8A LEFT EOT line shown below, hover for a moment to display the 
Profile Menu as shown below, then select the Set as Active Profile option. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

I. Notice in the View 2, Default 3D window that the TRIMMED LEFT EOT line is now displayed in 
the 3D model. This is because the LEFT EOT now has a vertical attribute associated with it and 
there is a Parent/Child relationship between the LEFT EOT line and the TRIMMED LEFT EOT 
line. 
 

 
 
 

SET AS ACTIVE 
PROFILE 

EXISTING Y8A 
LEFT EOT 

TRIMMED 
LEFT EOT  
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J. From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition 
button and then select the Road_Edge of Travel feature from the (Linear > Roadway > 
Pavement) folder as shown below. Keep this Feature active throughout all steps that follow.  

 
 
 
 
 
 
 
 
 
 
 
 

 
K. Next, select the Quick Profile Transition tool (Geometry > Vertical > Element Profiles > Quick 

Profile Transition) as shown below. 
 

 
 
L. Then, set the Quick Transition Method to Parabolic, left click to accept, and then select the 

Y8A Left Side Radius on the left side of the Y8A alignment as shown below. 
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M. Click the Y8A Left Side Radius shown below, hover for a moment to display the menu, and 
then select the Open Profile Model option to open the Proposed Y8A Radius profile. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
N. Notice the  Proposed Y8A Radius profile that was created using the Quick Profile Transition 

tool. The Quick Profile Transition tool created a best-fit profile for the Y8A Left Side Radius.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Note: This profile is dynamic. If the Y8 profile is changed, the Proposed Y8A Left Side Radius will 
reflect this change. 
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O. Notice in the View 2, Default 3D window that the Proposed Y8A Left Side Radius is now 
displayed in the 3D model. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

P. After profiling  the Y8A Left EOT lines, follow these same steps and profile the Y8A Right EOT 
lines to finalize the Side Street (Y8A) vertical as shown below.  

 

 
 
 
Note: The methodology used to profile the Y8A EOT lines is just one of several ways using 
OpenRoads Designer. See the Vertical Alignment module for more detailed information on 
OpenRoads Designer Vertical Geometry tools and methodology. 
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Y8A 
ALIGNMENT 

EOT 
DIRECTIONAL 

ARROW 

11. Complex the Side Street (Y8A) EOT lines 
A. Select the Complex By Element tool (Geometry > Horizontal > Complex Geometry > Complex 

By Element) as shown below. 
 

 
 
 

B. Then, Key the following parameters into the Create Complex Element dialog and select the 
small tangent EOT as shown below.  When selecting the EOT line, make sure the Directional 
Arrow is pointing in the correct direction before accepting.   

 

¶ Method = Automatic 

¶ Name = Y8A RIGHT EOT 
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C. This creates a new complex element called Y8A RIGHT EOT as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

D. Click the Y8A Right EOT shown below, hover for a moment to display the menu, and then 
select the Open Profile Model option to open the Y8A Right EOT profile. 
 
 

 
 

Y8A RIGHT 
EOT 

Y8A RIGHT 
EOT 

OPEN PROFILE 
MODEL 
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E. Select the Profile Complex By Element tool (Geometry > Vertical > Complex Geometry > 
Profile Complex By Element) as shown below. 

 
 
 
 
 
 
 
 
 

F. Then, similar to how the horizontal Y8A Right EOT was complexed, Key the following 
parameters into the Create Complex Profile Element dialog and select the small tangent EOT 
as shown below.  When selecting the EOT line, make sure the Directional Arrow is pointing in 
the correct direction before accepting. It may be helpful to turn the existing ground line off if 
you have trouble selecting the tangent EOT. 

 

¶ Method = Automatic 

¶ Name = Y8A RIGHT EOT 
 

 
 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

EOT 

DIRECTIONAL 
ARROW 



 

Module 11 - Detailed Modeling 
 

 
 

Page | 31  
 
 

G. This creates a new complex vertical element called Y8A RIGHT EOT as shown below. Set Y8A 
Right EOT as the Active Profile.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

H. After complexing  the Y8A Right EOT lines, follow these same steps and complex the Y8A Left 
EOT lines. 
 

12. Apply Linear Templates to the Left and Right Y8A EOT lines 
A. Select the Apply Linear Template tool (Model Detailing > Apply Linear Template). 
B. Key the following parameters into the Apply Linear Template dialog. 

 

¶ Start = Lock To Start 

¶ End = Lock To End  

¶ Exterior Corner Sweep Angle = 05̄  ллΩ ллέ 

¶ Template = LNT - C&G Berm Catch Slopes 

¶ Feature Definition = Design 

¶ Name = Y8A LEFT EOT 
 
 
 
  
 
 
 
 

Y8A RIGHT 
EOT 
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PROFILE 
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Y8A LEFT EOT 
LINEAR TEMPLATE 

Y8A RIGHT EOT 
LINEAR TEMPLATE 

C. When prompted to Locate Element To Apply Template, select the Y8A LEFT EOT and begin 
clicking through the prompts. When prompted to Select Side, move your cursor as shown 
below and then continue clicking through the prompts to place the Linear Template.  
 
 
 
 
 
 
 
 
 
 
 

 
D. Notice in the View 2, Default 3D window that the Y8A Left EOT Linear Template  is now 

displayed in the 3D model as shown below. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

E. After applying the Linear Template to Y8A Left EOT, follow these same steps and apply the to  
the same Linear Template to Y8A Right EOT as shown below. 
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13. Create a Proposed Terrain for the Side Street (Y8A) 
A. First, select the Project Profile To Element tool (Geometry > Vertical > Profile Creation > 

Project Profile to Element) as shown below. 
 
 
 
 
 
 
 
 
 
 

B. When prompted to Select Element To Project, select the Right EOT line for the Y8 Corridor. 
When selecting the Y8 Corridor Reft EOT line you may notice multiple linear elements sitting 
on top of one another. To resolve this, Right-Click to cycle through them and choose the linear 
element on level P_RDY_TL_Edge_of_Travel.  LǘΩǎ ǾŜǊȅ IMPORTANT to select the correct linear 
element. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Y8 CORRIDOR RIGHT EOT 
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C. Then select the Shear Line on level Draft_RDY_Construction_Element when prompted to 
Select Plan Element To Project Onto. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

D. Notice in the View 2, Default 3D window that the Shear Line  is now displayed in the 3D model 
matching the Y8 EOT as shown below. 
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E. Now, select the Element Selection tool (Terrain > Selection > Element Selection) and 
Toggle ON the Add option as shown below. 

 
 
 
 
 
 
 
 
 
 

F. Then, select he four (4) elements Highlighted in Blue below. Because there are multiple 
elements sitting on top of one another, you may need to Right-Click through the elements to 
select the ones you need. If your still having trouble, try turning off some of the additional 
levels.  
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G. Now, select the Create Terrain From Elements tool (Terrain > Create > From Elements) as 
shown below. 

 
 
 
 
 
 
 
 

H. Still keeping those four (4) elements selected, key the following parameters into the Create 
Terrain From Elements dialog. 
 

¶ Feature Type = Boundary 

¶ Edge Method = None  

¶ Feature Definition = PT_Triangles 
 
 
 
 
 
 
 
 
 
 
 

I. Finally, Left-Click through the prompts to create the Side Street (Y8A) Terrain Model as shown 
below. 

 
 
 
 
 
 
 
 
 
 
 

Y8A TERRAIN 
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14. Apply Pavement Surface Template to the Side Street (Y8A) Terrain Model 
A. Select the Apply Surface Template tool (Model Detailing > Surface Templates > Apply Surface 

Template) as shown below. 
 
 
 
 
 
 
 
 

B. Then, key the following parameters into the Apply Surface Template dialog as shown below 
and select the Y8A Terrain Model from within the View 2, Default 3D window when prompted 
to Locate Terrain Model. 
 

¶ Template = SFT-Pavement 

¶ Feature Definition = Disable Linear Features 
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C. Continue left clicking through the prompts to apply the  SFT-Pavement Surface Template to 
the Y8A Terrain as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

D. Turn off the Terrain Levels to better see the SFT-Pavement Surface Template as shown below. 
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15. Add a Concrete Channelization Island to the Side Street (Y8A) 
A. From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition 

button and then select the Monolithic Island feature from the (Linear > Roadway > 
Intersection) folder as shown below. Keep this Feature active throughout all steps that follow.  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

B. Next, select the Single Offset Entire Element tool (Geometry > Horizontal > Offsets and 
Tapers > Single Offset Entire Element) and key the following parameters into the as shown 
below.  

 
 
 
 
 
 
 
 

¶ Offset = 12.0000 

¶ Use Spiral Transitions = Unchecked 

¶ Mirror = Unchecked 

¶ Remove Offset Rule = Unchecked 
 
 
 
 
 
 

USE ACTIVE 
FEATURE 

DEFINITION 

FEATURE 
DEFINITION 
DROPDOWN 



 

Module 11 - Detailed Modeling 
 

 
 

Page | 40  
 
 

C. Then, select the two (2) Y8A EOT radius returns and follow the prompts to place the two (2) 
Island Edges as shown below.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

D. Change the Offset value to пΩ within the Single Offset Entire Element dialog, this time 
selecting the Y8 Right Shear Line as shown below to place the 3rd  and final Island Edge line.  
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E. Next,  select the Simple Arc tool (Geometry > Horizontal > Arcs > Arc Between Elements > 
Simple Arc).  Set the Radius parameter to нΩ and the Trim/Extend parameter to Both within 
the dialog as shown below.  

 
F. Now, use the Simple Arc tool to fillet the three (3) corners of the concrete island as shown 

below.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

нΩ  нΩ  

нΩ  
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G. Select the Complex By Element tool (Geometry > Horizontal > Complex Geometry > Complex 
By Element). Set the Method to Automatic and click on the Concrete Island when prompted.  

 

 
H. Click through the additonal prompts to complex the Concrete Island, making it a single 

complex element.  
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I. Next, select the Quick Profile From Surface tool (Geometry > Vertical > Profile Creation > 
Quick Profile From Surface) and select the Concrete Island when prompted to Locate 
Reference Element. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

J. Then, select the Side Street (Y8A) Terrain Model when prompted to Locate Reference 
Surface. Right click to reset and finalize the command. 
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K. Click the Concrete Island shown below, hover for a moment to display the menu, and then 
select the Open Profile Model option to open the Proposed Concrete Island profile. 

L.  
 
 
 
 
 
 
 
 
 
 
 
  
 

 
 
 

M. Notice the proposed Concrete Island profile that was created using the Side Street (Y8A) 
Terrain Model as shown below. Set this as the Active Profile and then close out of the profile 
window. 
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N. Notice in the View 2, Default 3D window that the Proposed Concrete Island is now displayed 
in the 3D model matching the surface of the Side Street (Y8A) Terrain Model as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
O. Select the Apply Linear Template tool (Model Detailing > Apply Linear Template) 

and key the following parameters into the Apply Linear Template dialog. 
 

¶ Start = Lock To Start 

¶ End = Lock To End  

¶ Exterior Corner Sweep Angle = 05̄  ллΩ ллέ 

¶ Template = Concrete Island Template Linear 

¶ Feature Definition = Design 

¶ Name = Y8A ISLAND  
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P. When prompted to Locate Element To Apply Template, select the Concrete Island and begin 
clicking through the prompts. When prompted to Select Side, move your Cursor to the inside 
of the Concrete Island as shown below and then continue clicking through the prompts to 
place the Linear Template.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Q. Notice in the View 2, Default 3D window that the Y8A Concrete Island Linear Template  is 

now displayed in the 3D Model as shown below. 
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R. Next, select the Element Selection tool (Terrain > Selection > Element Selection) and 
select the top of the Y8A Concrete Island Linear Template. See the element highlighted 
in blue below.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tip: Zoom in closely and right click to tab through until you get the correct line.  
 

S. Now, select the Create Terrain From Elements tool (Terrain > Create > From Elements) as 
shown below. 
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T. Still keeping the Concrete Island Linear Template selected, key the following parameters into 
the Create Terrain From Elements dialog. 
 

¶ Feature Type = Boundary 

¶ Edge Method = None  

¶ Feature Definition = PT_Triangles 
 

 
 
 
 
 
 
 
 
 
 
 
 

U. Left click through the prompts to create the Y8A Concrete Island Terrain Model as shown 
below. 
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V. Select the Apply Surface Template tool (Model Detailing > Surface Templates > Apply Surface 
Template). 

W. Then, key the following parameters into the Apply Surface Template dialog as shown below 
and select the Y8A Concrete Island Terrain Model from within the View 2, Default 3D window 
when prompted to Locate Terrain Model. 

 

¶ Template = SFT-Concrete Monolithic Island-Simple 

¶ Feature Definition = Disable Linear Features  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

X. Continue left clicking through the prompts to apply the  SFT_Concrete Monolithic Island-
Simple Surface Template to the Y8A Concrete Island Terrain as shown below. 
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Y. Turn off the Terrain Levels to better see the applied SFT_Concrete Monolithic Island-Simple 
Surface Template. 

 
 

16. Adjust the berms and slopes of the Side Street (Y8A) Radius Returns to match Y8 
A. Notice that the berm and slopes of the Side Street (Y8A) do not match the Y8 as shown below. 

This can easily be resolved by using Parametric Constraints. 
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B. Select the Create Parametric Constraint option (Corridors > Edit > Edits > Create Parametric 
Constraint) and then select the Side Street (Y8A) radius return Corridor Object when 
prompted to Locate Corridor.  

 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 

 
 
 
 
 
 

C. Key the following Parameters into the Create Parametric Constraint dialog and click through 
the prompts to set the BM_Width Parametric Constraint and transition the Berm Width from 
уΩ to млΩ over the length of the Radius Return to match the Y8 Berm. 
 

¶ Start = Lock to Start 

¶ Stop = Lock to End 

¶ Constraint Label = BM_Width 

¶ Start Value = 8.0000 

¶ Stop Value = 10.000 
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D. Next, use the  SS_Slope Fill Parametric Constraint to transition the Y8A Fill Slope from 2:1 to 
4:1 over the length of the Radius Return to match the Y8 Fill Slope. 
 

¶ Start = Lock to Start 

¶ Stop = Lock to End  

¶ Constraint Label = SS_Slope Fill 

¶ Start Value = -50.00% 

¶ Stop Value = -25.00% 
 

 
 
 
 

E. Now, follow these same steps and do the same for the other Y8A Radius Return as shown 
below. 
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17. Clean up the breaks in the intersection using Key-Stations 
A. Notice the breaks in the intersection model as shown below. This can be resolved by adding 

Key Stations. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

B. Select the Create Key Station tool (Corridors > Edit > Edits > Create Key Station) and add the 
following two (2) Key Stations. 

 

¶ Key Station 1 = 12+12.99 

¶ Key Station 2 = 13+07.01  
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C. This finalizes the Side Street (Y8A) intersection model as shown below.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Exercise 2 ς Directional Crossover with Median U-Turns Modeling  
 

In this exercise, you will learn how to model a Directional Crossover with Median U-Turns. This 
includes pavement shearing, median/pavement switching, bulb-outs, directional median cross-over 
modeling, intersection radius modeling, application of linear templates, proposed terrain model 
development, surface template application, and various element profiling techniques. Design Intent 
will continue to be a major focus. 
 
Throughout this exercise you will be working with NCDOT 2D dgn files exclusively. All design and 
corridor manipulation will be carried out within a 2-dimensional design plane. 
  
1. Launch OpenRoads Designer CONNECT Edition 
             Doble-click on the NCDOT Roadway OpenRoads icon on your desktop to launch 
             OpenRoads Designer into the NCDOT Roadway workspace. 
 
2. Set the Workspace and Workset 
             Select DOT-US North Carolina from the Workspace menu. 
             Select NCDOT R-2635C (Training) from the Workset menu. 
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3. Open the Exercise 2 Corridor (CMD) dgn file and zoom in closely to the Super Street 
Intersection 
A. Click the browse button and path to the Module 11 (Detailed Modeling) folder and 

open the R-2635C-RDY_CMD_Exercise2.dgn file. 
B. Zoom in close to the intersection as shown below. For the sake of time and the avoidance of 

redundancy a number of elements have already been modeled. The end result after finishing 
Exercise 2 will be a completed Super Street model. 
 
 

 
 
 
 
 
 
 
 
 

C. In addition to the preemptive modeling, notice that some of the 2D linework has already been 
designed allowing this module to focus more on Detailed Modeling. See the Plan Geometry 
Module for detailed instructions on 2D plan geometry development. 
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4. Remove the grass median and display pavement within the Super Street Intersection limits 
A. Notice that a portion of the Y8 Corridor has a grass median within the limits of the 

Super Street Intersection. This can be adressed using Paramtric Constraints that 
are included within the attached NCDOT template. 

 
 
 
 
 
 
 
 
 
 
 
 

B. Select the CƻǊǊƛŘƻǊ hōƧŜŎǘǎ ά¢ƘŜ .ǳŎƪŜǘέ tool (Corridors > Edit > 
Corridor Objects) and then select the Y8 corridor when prompted to 
Locate Corridor.  

 
 
 

C. Notice the three (3) Parametric Constraints that have already been defined as shown below.  
 
 
 
 
 
 
 
 
 

¶ PV_Shear_Inside LT = Shears the left Inside curb and median when set to -1 

¶ PV_Shear_Inside RT = Shears the right inside curb and median when set to 1 

¶ X_Over_Switch = Displays the median pavement when set to 1 
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D. Adjust the start station value for all three (3) Parametric Constraints to 13+27.86 as shown 
below. This will remove the median and display the pavement throughout the limits of the 
Super Street Intersection. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. Model the bulb-out on the right side of the Y8 corridor 

A. From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition 
button and then select the Road_Edge of Travel feature from the (Linear > Roadway > 
Pavement) folder as shown below. Keep this Feature active throughout all steps that follow.  
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B. Use the Complex By Element tool (Geometry > Horizontal > Complex Geometry > Complex By 
Element) to complex the individual 2D Elements that make up the bulb-out as shown below. 
Combining these and making a single complex element will be more efficient for modeling. 

 
 
 
 
 
 

 
C. Next, select the Profile By Slope From Element tool (Geometry > Vertical > Element Profiles > 

Profile By Slope From Element) and select the Complexed Bulb-Out Element when prompted 
to Locate First Element To Profile. Then Right-Click to Reset And Complete. 
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D. When prompted to Locate Reference Element, select the Right EOT line for the Y8 Corridor. 
When selecting the Y8 Right EOT line you may notice multiple linear elements sitting on top of 
one another. To resolve this, Right-Click to cycle through them and choose the linear element 
on level P_RDY_TL_Edge_of_Travel.  LǘΩǎ very IMPORTANT to select the correct linear element. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

E. Then, key the following parameters into the Profile By Slope From Element dialog and click 
through the prompts to Profile the Bulb-Out element using a -2.5% slope from the Y8 EOT as 
shown below. 

 

¶ Point Selection = All  

¶ Profile Adjustment = None 

¶ Vertical Offset = 0.0000 

¶ Slope = -2.50% 
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6. Shear the Y8 pavement through the Bulb-Out limits  
A. From the Feature Definition Toggle Bar, toggle On the Use Active Feature Definition 

button and then select the CCE_Target_EOT_Shear_Out_RT feature from the (Linear > 
Roadway > Construction Class Element) folder as shown below.  

 
 
 
 
 
 
 
 
 
 
 
 

B. Select the Single Offset Partial option (Geometry > Horizontal > Offsets and Tapers > Single 
Offset Partial) as shown below and select the Y8 alignment when prompted to Locate 
Element.  

 
 
 
 
 
 
 

C. When prompted for a Start and End Location, snap to the following locations as shown below. 
This places the Shear Line.  
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